
 

This Content is written by Prof. Rashid Rizwi, email: contactus@marstraining.in | 

rashidraj97@gmail.com, website: www.marstraining.in , Voice: +91 9870259245 | +91 

9867356452 

 

 

 

 

 

 

 

 

Excel VBA Macro 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

mailto:contactus@marstraining.in/
mailto:rashidraj97@gmail.com
http://www.marstraining.in/


 

This Content is written by Rashid Rizwi, email: contactus@marstraining.in | rashidraj97@gmail.com, 

website: www.marstraining.in , Voice: +91 9870259245 | +91 9867356452 

 

 

    

 

 

 

Table of Contents 

 

 
About Excel Macro (VBA) ................................................................................................................... 1 
What is Module? ................................................................................................................................... 1 

Types of Modules ............................................................................................................................... 1 
Form Module 1 
Standard Module 1 
Class Module 1 

Record or Run a Macro ........................................................................................................................ 2 
Show the Developer tab ...................................................................................................................... 2 
Record a macro ................................................................................................................................... 2 

Change the keyboard shortcut for a macro 3 
Writing a Macro .................................................................................................................................... 4 

Run a macro ........................................................................................................................................ 4 
Write a macro from scratch ................................................................................................................ 4 

How to Add Macro to the Quick Access Toolbar .............................................................................. 5 
To remove the macro button from the Quick Access toolbar ............................................................. 6 

What is a Procedure: VBA Sub Procedures & Function Procedures .............................................. 6 
How Does a VBA Sub Procedure Look Like ..................................................................................... 7 
Visual Basic User Define Functions(UDFs) ...................................................................................... 9 

Proper Method to Create Excel User Defined Functions 9 
Benefits of User Defined Excel Functions ....................................................................................... 10 
Limitations of UDF's ........................................................................................................................ 10 

Example 1: Get the sum based on cell color 10 
Example 2: Get the Address of a Hyperlink 11 

InputBox Function .............................................................................................................................. 11 
About Add-Ins ..................................................................................................................................... 13 

How to create an Excel add-in .......................................................................................................... 13 
How to Install Add-Ins ..................................................................................................................... 14 
Controls From the Control Toolbox Toolbar ................................................................................... 19 

VBA Error Handling .......................................................................................................................... 20 
Introduction ...................................................................................................................................... 20 

Why Loops? ......................................................................................................................................... 24 
VBA Loops ....................................................................................................................................... 24 

Procedures Examples .......................................................................................................................... 25 
To Protect a  sheet ............................................................................................................................ 25 
To Unprotect a  sheet ........................................................................................................................ 25 
To Print a sheet ................................................................................................................................. 25 
To make gridlines off of sheet .......................................................................................................... 25 
Defining the range name .................................................................................................................. 26 
To select entire Column .................................................................................................................... 26 
To select entire Row ......................................................................................................................... 26 
Deleting the sheet without display alert ........................................................................................... 26 
To delete conditional formatting ...................................................................................................... 26 
To clear validation ............................................................................................................................ 26 
To create a series .............................................................................................................................. 27 

mailto:contactus@marstraining.in/
mailto:rashidraj97@gmail.com
http://www.marstraining.in/


 

This Content is written by Rashid Rizwi, email: contactus@marstraining.in | rashidraj97@gmail.com, 

website: www.marstraining.in , Voice: +91 9870259245 | +91 9867356452 

 

 

    

 

 

To use vbOKCancel ......................................................................................................................... 27 
To change font color ......................................................................................................................... 27 
To change back color ........................................................................................................................ 28 
To Count Workbook ......................................................................................................................... 28 
To insert worksheet .......................................................................................................................... 28 
To insert n no of worksheets same time ........................................................................................... 28 
To insert worksheet at the end .......................................................................................................... 29 
To delete a worksheet ....................................................................................................................... 29 
To rename a worksheet ..................................................................................................................... 29 
Take input as sheet name from excel sheet. ..................................................................................... 29 
To display all sheets name in msg box ............................................................................................. 30 
To increase the column width ........................................................................................................... 30 
To autofit rows & columns ............................................................................................................... 30 
To insert a chart for fixed range ....................................................................................................... 30 
To insert a chart for current range .................................................................................................... 31 
To unhide rows and columns ............................................................................................................ 31 
Write VBA Code to remove blank spaces from selected Cells ........................................................ 31 
Write a VBA Codes to change the number with two decimal format. ............................................. 31 
Calling Macro ................................................................................................................................... 31 

Functions Examples(UDFs) ................................................................................................................ 32 
Function Without Argument to get current month ........................................................................... 32 
Function QuarterNum(Enter_Date) .................................................................................................. 32 
Function to check range name existence .......................................................................................... 32 
Numeric Handling ............................................................................................................................ 32 

Function to extract digit 32 
Function to Calculate Itax using nested IF 33 
Function to get reverse number 33 

String Handling ................................................................................................................................ 33 
To get Initial of passed string 33 

List of Built in Keywords in VBA: .................................................................................................... 34 

 

 

 

  

 

mailto:contactus@marstraining.in/
mailto:rashidraj97@gmail.com
http://www.marstraining.in/


 

This Content is written by Rashid Rizwi, email: contactus@marstraining.in | rashidraj97@gmail.com, 

website: www.marstraining.in , Voice: +91 9870259245 | +91 9867356452 

 

 

 

About Excel Macro (VBA) 
 

VBA, which stands for Visual Basic for Applications, is a programming language developed by  

Microsoft Excel, along with the other members of Microsoft Office 2003, includes the VBA language (at 

no extra charge). In a nutshell, VBA is the tool that people like you and me use to develop programs that 

control Excel. Don't confuse VBA with VB (which stands for Visual Basic). VB is a programming language 

that lets you create standalone executable programs (those EXE files). Although VBA and VB have a lot 

in common, they are different animals 

 

What is Module? 
 

A module is basically where you store programming code of some kind. It might be code that operates 

behind a form, or a module which all of your application uses, but either way a module is where code is 

stored. 

 

In VBA there are three different types of module - a Form Module, A standard Module and a Class Module. 

I'll quickly explain the differences.  

Types of Modules 
 

Form Module 
A form module is one which is linked directly to a form within the application that you're using, whether 

it's Access, Excel or Visual Basic itself, you can think of the Form Module as the engine room of the form 

if it has calculations  to do, or procedures to carry out. 

 

 

Standard Module 
A standard module can be used for various different things. Standard modules are often used to store 

functions, procedures and variables used by other parts of the application and are usually created as an 

organized 'bucket' of useful and related items. For example you may have a variable which is used by every 

form within your project. Rather than having to declare that variable in every form or subroutine you can 

declare it globally within a normal module and it will be available by the whole program. 

 

Class Module 
Class modules are a little more tricky and involve Object Oriented Programming (or OOP). They allow you 

to create 'Objects' which can be used within your programs. 

A class is the formal definition of an object. The class is a template for the creation of the object during 

programming, and defines the properties and methods that decide how the object behaves. Class modules 

is new in Office97.With class modules it's possible to create your own objects. These objects can have 

properties and methods like the built-in objects, and you can create several copies of an object if you need 

to. Programmers have managed without class modules earlier, and the reason for using class modules may 

not become obvious before you have used class modules for a while. 
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Record or Run a Macro 

In Microsoft Office Excel 2013, you can automate frequently used tasks by creating and running 

macros. A macro is a series of commands and instructions that you group together as a single 

command to accomplish a task automatically. 

Typical uses for macros are: 

 To speed up routine editing and formatting 

 To combine multiple commands — for example, to insert a table with a specific size and borders, 

and with a specific number of rows and columns 

 To make an option in a dialog box more accessible 

 To automate a complex series of tasks 

You can record a sequence of actions, or you can write a macro from scratch by entering code in 

the Visual Basic Editor  

Show the Developer tab 

1. Click File Tab, and then click Options. 

2. Click Customize Ribbon. 

3. Under right part of windows, select Developer tab check box. 

4. Click Ok 

Record a macro 

1. On the Developer tab, in the Code group, click Record Macro. 

 

2. In the Macro name box, type a name for the macro. 

 Note   If you give a new macro the same name as a built-in macro in Office Excel 2013, 

the new macro actions will replace the built-in macro. To view a list of built-in macros, 

on the Developer tab, in the Code group, click Macros. In the Macros in list, click 

Excel Commands. 

3. In the Store macro in box, click the or document in which you want to store the macro. 

 Important   To make your macro available in all documents, be sure to click 

Normal.dotm. 
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4. In the Description box, type a description of the macro. 

5. Do one of the following: 

o Begin recording  To begin recording the macro without assigning it to a button on the 

Quick Access Toolbar or to a shortcut key, click OK. 

o Create a button  To assign the macro to a button on the Quick Access Toolbar, do the 

following: 

1. Click Button. 

2. Under Customize Quick Access Toolbar, select the document (or all 

documents) for which you want to add the macro to the Quick Access Toolbar. 

 Important   To make your macro available in all documents, be sure to 

click Normal.dotm. 

3. Under Choose commands from dialog box, click the macro that you are 

recording, and then click Add. 

4. To customize the button, click Modify. 

5. Under Symbol, click the symbol that you want to use for your button. 

6. In the Display name box, type the macro name that you want to display. 

7. Click OK twice to begin recording the macro. 

The symbol that you choose is displayed in the Quick Access Toolbar. The name 

that you type is displayed when you point to the symbol. 

o Assign a keyboard shortcut  To assign the macro to a keyboard shortcut, do the 

following: 

1. Click Keyboard. 

2. In the Commands box, click the macro that you are recording. 

3. In the Press new shortcut key box, type the key sequence that you want, and 

then click Assign. 

4. Click Close to begin recording the macro. 

6. Perform the actions that you want to include in the macro.  

 Note   When you record a macro, you can use the mouse to click commands and options, 

but not to select text. You must use the keyboard to select text. For more information 

about selecting text by using the keyboard, see Select text. 

7. To stop recording your actions, click Stop Recording in the Code group. 

Change the keyboard shortcut for a macro 

1. Click the Developer tab 

2. Click Macro icon in code group. 

3. In the Macros list, click the macro that you want to change. 

4. Then click Option tab 

5. In the Press new shortcut key box, type the key combination that you want to choose. 

6. Check the Current keys box to make sure that you aren't assigning a key combination that you 

already use to perform a different task. 

7. Then Close window . 
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Writing a Macro 

As an alternative to recording a macro, we can create one explicitly. Press F8 from inside the 

workbook, and when presented with the Macro dialog give the new macro a name of Example1 

and press the Create button. Once inside the Visual Basic editor key in the following code: 

Sub Example1() 

    ActiveCell = "hello techbookreport" 

End Sub 

Switch back to the Excel workbook, select a cell on a worksheet and press Alt-F8. This time 

Example1 should be listed in the dialog box, select it and then click on the run button and you 

should find that "hello techbookreport" has been entered into the current cell. Move to another 

cell and run it again and the same thing should happen. Congrats - you've coded your first VBA 

program. 

Run a macro 

1. On the Developer tab, in the Code group, click Macros. 

 

2. In the list under Macro name, click the macro that you want to run. 

3. Click Run. 

Write a macro from scratch 

1. On the Developer tab, in the Code group, click Macros. 

 

2. In the Macro name box, type a name for the macro. 

 Note   If you give a new macro the same name as a built-in macro in Office Excel 2013, 

the new macro actions will replace the built-in macro. To view a list of built-in macros, 

click Excel Commands in the Macros in list. 

3. In the Macros in list, click the or document in which you want to store the macro. 
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To make your macro available in all documents, be sure to click Normal.dotm. 

4. Click Create to open the Visual Basic Editor. 

After you open the Visual Basic Editor, you may want more information about working with 

Visual Basic for Applications. For more information, click Microsoft Visual Basic Help on the 

Help menu or press F1. 

 

How to Add Macro to the Quick Access Toolbar 

You can assign a macro created in Excel 2013 to a custom button on the Quick Access toolbar 

and then run it by clicking that button. This provides quicker access to a macro than using the 

Macro dialog box. 

Steps: 

1. Click File tab and then click the Options button. 

2. The Excel Options appears. 

 
 

 

3. Click the Customize tab 

4. The Customize options appear in the right pane. 

5. Click Macros in the Choose Commands From drop-down list box. 

6. Excel lists the names of all macros created in the current workbook and those saved in the 

PERSONAL.XLSB workbook in the Choose Commands From list box. 

7. Select the name of the macro and click the Add button. 

8. The macro appears in the list box on the right side of the dialog box. 
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9. Click the macro name in the list box on the right and then click the Modify button. 

10. The Modify Button dialog box appears. 

11. Select an icon to use for the button. 

12. This is the, that will appear on the Quick Access toolbar to represent your macro. 

13. Click OK two times.Both dialog boxes close and the macro button appears on the Quick Access 

toolbar. 

 

 

To remove the macro button from the Quick Access toolbar 

Simply right-click the button and select remove from Quick Access Toolbar. 

 

What is a Procedure: VBA Sub Procedures & 

Function Procedures 
When you're using Excel's Visual Basic Editor, a procedure is the block of statements that is 

enclosed by a particular declaration statement and End declaration. The main purpose of a 

procedure is to carry out a particular task or action. 

VBA instructions are generally within a procedure. Therefore, if you want to master Visual Basic 

for Applications and macros, you should get familiar with this topic. 

The 2 most common types of procedures in Visual Basic for Applications are Sub 

procedures and Function procedures 

The main difference between VBA Sub procedures and Function procedures is the 

following: 

 VBA Sub procedures perform an action with Excel. 

 

In other words, when you execute a VBA Sub procedure, Excel does something. What happens in 

Excel depends on what the particular VBA code says. 
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 Function procedures carry out calculations and return a value. As explained by John Walkenbach 

in Excel VBA Programming for Dummies, this value can be either a single value or an array. 

 

If you've worked with regular Excel functions and formulas, you already have a good basis to 

understand how Function procedures work. Function procedures work similarly to regular Excel 

functions; they carry out certain calculations behind the scenes before returning a value. 

Most of the macros you write in VBA are Sub procedures. 

Additionally, if you use the macro recorder to create a macro, Excel always creates a VBA Sub 

procedure. 

The above comments make it quite clear that you'll be working quite a bit with VBA Sub 

procedures. Therefore, let's start taking a more detailed look at them… 

How Does a VBA Sub Procedure Look Like 
The image below shows how a basic VBA Sub procedure looks like in the Visual Basic Editor. 

Notice how, this VBA Sub procedure: 

 Begins with the declaration statement “Sub”. 

 

 

 Has an End declaration statement. 

 

 

 Has a block of statements that is enclosed by the declaration and End declaration statements. 
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The purpose of this particular VBA Sub procedure, named “Delete_Blank_Rows_3”, is to delete 

rows when some of the cells in those rows are blank. 

Before we continue, let's take a look at the first statement of this VBA Sub procedure. There are 

3 items: 

 The Sub keyword which you already know is used to declare the beginning of the VBA Sub 

procedure. 

 

 

 The name of the VBA Sub procedure. 

 

VBA Sub procedure names must follow certain rules, which I explain in the following section. 

 

 

 Parentheses. 

 

If you're creating a particular VBA Sub procedure that uses arguments from other procedures, you 

should list them here. The arguments must be separated by a comma (,). 

 

You can have a VBA Sub procedure without arguments (they're optional). However, the 

parentheses themselves aren't. If the relevant procedure uses no arguments, such as the example 

above, you must have the set of empty parentheses. 

Four elements that are required in any VBA Sub procedure: 

 Sub statement. 

 

 

 Name. 

 

 

 Parentheses. 

 

 

 End Sub keyword. 

Two elements that are optional: 

 The list of arguments that may go within the parentheses. 

 

 

 The valid VBA instructions that are enclosed by the declaration and End declaration statements. 
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Visual Basic User Define Functions(UDFs) 

You are already used to using Excel functions in worksheets - sum, average, max, min, all of the 

standard worksheet formulae are functions. Typically they take in a set of numbers from one or 

more cells and compute a result and write out a result in a different cell (e.g. =SUM(A1:B10)). 

More formally we say that a function takes in a set of parameters (or arguments, as they are 

sometimes called), and it produces a value as a result. 

VBA allows you to write your own functions which you can use in a workbook or as part of a 

larger program. In the VB editor functions start with 'Function FunctionName()' and ends with 

'End Function'. To return a value your VB code must assign a value to the function name at some 

point, e.g. if we have a function called sqr that returns the square of a number, the code would look 

like this: 

Function SQR(n) 

    sqr = n * n 

End Function 

Note that r is the variable that we're squaring. To use this function to square the value in cell A1 

we would enter =SQR(A1) in a cell and Excel will calculate the result and place it in the cell 

containing the formula. 

However, when we recorded our first macro earlier it wasn't a function. Excel created a Procedure 

for us. A VB procedure is a block of program code that performs one or more tasks and which 

does not necessarily return a value. Blocks of procedure code start with 'Sub ProcName()' and 

finish with 'End Sub'. Although procedures do not return a value they can accept parameters, and 

these have to be listed in the procedure definition. More of this later. 

In Excel VB code is stored in an object called a 'Module', which may contain one or more functions 

and/or procedures, each defined using the 'Sub … End Sub' and 'Function … End Function' 

constructs. A workbook may contain any number of modules, which lends itself to a more 

structured approach to coding than having huge blocks of code into a single unwieldy lump. 

Keeping things simple and well-structured makes it easier to track down errors, and easier to build 

complicated programs from smaller building blocks. This is a good thing. 

Proper Method to Create Excel User Defined Functions 

1. Open up a new workbook. 

2. Get into VBA (Press Alt+F11) 

3. Insert a new module (Insert > Module) 

4. Copy and Paste the Excel user defined function examples - 

5. Get out of VBA (Press Alt+Q) 

6. Use the functions (They will appear in the Paste Function dialog box, Shift+F3, under the "User 

Defined" category) 

If you want to use a UDF in more than one workbook, you can save your functions in your own 

custom Add-Ins.Simply save your excel file that contains your VBA functions as an Add-Ins file 
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(.xla/.xlam). Then load the add-in (Tools > Add-Ins...). Warning! Be careful about using custom 

functions in spreadsheets that you need to share with others. If they don't have your add-in, the 

functions will not work when they use the spreadsheet. 

Benefits of User Defined Excel Functions 

 Create a complex or custom math function. 

 Simplify formulas that would otherwise be extremely long "mega formulas". 

 Diagnostics such as checking cell formats. 

 Custom text manipulation. 

 Advanced array formulas and matrix functions. 

Limitations of UDF's 

 Cannot "record" an Excel UDF like you can an Excel macro. 

 More limited than regular VBA macros. UDF's cannot alter the structure or format of a 

worksheet or cell. 

 If you call another function or macro from a UDF, the other macro is under the same limitations 

as the UDF. 

 Cannot place a value in a cell other than the cell (or range) contain the formula. In other words, 

UDF's are meant to be used as "formulas", not necessarily "macros". 

 Excel user defined functions in VBA are usually much slower than functions compiled in C++ or 

FORTRAN. 

 Often difficult to track errors. 

 If you create an add-in containing your UDF's, you may forget that you have used a custom 

function, making the file less sharable. 

 Adding user defined functions to your workbook will trigger the "macro" flag (a security issue: 

Tools > Macros > Security...). 

Example 1: Get the sum based on cell color 

The following example can be useful when user want to get sum of colored cell(background). 

Function ColSum(rng As Range) 

    For Each Cell In rng 

     If Cell.Interior.ColorIndex > 0 Then 

     Sum = Sum + Val(Cell.Value) 

     End If 

     Next 

    colsum = Sum 

End Function 
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Example 2: Get the Address of a Hyperlink 

The following example can be useful when extracting hyperlinks from tables of links that have 

been copied into Excel, when doing post-processing on Excel web queries, or getting the email 

address from a list of "mailto:" hyperlinks. 

This function is also an example of how to use an optional Excel UDF argument. The syntax 

for this custom Excel function is: 

=LinkAddress(cell,[default_value]) 

To see an example of how to work with optional arguments, look up the IsMissing command 

in Excel's VBA help files (F1). 

Function LinkAddress(cell As range, _  

                     Optional default_value As Variant)  

  'Lists the Hyperlink Address for a Given Cell  

  'If cell does not contain a hyperlink, return default_value  

  If (cell.range("A1").Hyperlinks.Count <> 1) Then  

      LinkAddress = default_value  

  Else  

      LinkAddress = cell.range("A1").Hyperlinks(1).Address  

  End If  

End Function  

 

InputBox Function 

As you may, or may not know, there are multiple types we can use. The code below will show 

you some of these types. We will kick off we the most common use of an INPUTBOX, collect 

text 

Sub StandardInputBox() 
Dim strName As String 

     

    'InputBox(prompt[, title] [, default] [, xpos] [, ypos] [, helpfile, context]) 

    strName = InputBox("Enter you name.", "NAME COLLECTOR") 

    'Exit sub if Cancel button used or no text entered 

    If strName = vbNullString Then Exit Sub 

     

    MsgBox "Hello " & strName 

 

End Sub 

Now we can look at how we can use Application.InputBox with different types. 

Type Meaning 

0 A formula 

1 A number 
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2 Text (a string) 

4 A logical value (True or False) 

8 A cell reference, as a Range object 

16 An error value, such as #N/A 

64 An array of values 

 

 

Sub NumbersOnly() 

Dim dNum As Long 

 

    'expression.InputBox(Prompt, Title, Default, Left, Top, HelpFile, HelpContextID, Type) 

    dNum = Application.InputBox("Enter you age.", "AGE COLLECTOR", , , , , , 1) 

    'Exit sub if Cancel button used 

    If dNum = 0 Then Exit Sub 

     

    'As we have used Type 1 Inputbox, Excel will handle any text entered 

    MsgBox "You are " & dNum & " Years old." 

 

End Sub 
 

 

Sub RangeAsObject() 
Dim rRange As Range 

Dim lReply As Long 

 

'We use On Error so we ignore run time errors 

On Error Resume Next 

  'expression.InputBox(Prompt, Title, Default, Left, Top, HelpFile, HelpContextID, Type) 

Set rRange = Application.InputBox("With you mouse, select a range of cells.", _ 

    "RANGE COLLECTOR", , , , , , 8) 

On Error GoTo 0 

 

    'Check if range is valid 

    If rRange Is Nothing Then 

        'If range not valid, ask if they wish to retry 

        rRange = MsgBox("Non valid range. Try again?", vbOKCancel + vbQuestion) 

            If rRange = vbCancel Then 'No retry 

                Exit Sub 

            Else 'retry 

                Run "RangeAsObject" 

            End If 

    Else 

       MsgBox rRange.Address 

    End If 

End Sub 

Now let's see how we can the INPUTBOX to evaluate a chosen range with an expression 

collected from a user. 

Sub CollectExpressions() 
Dim strExpression As String 

Dim rRange As Range 
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    On Error Resume Next 

    Set rRange = Application.InputBox("With you mouse, select a range of cells to evaluate.", _ 

        "RANGE COLLECTOR", , , , , , 8) 

    On Error GoTo 0 

 

        If rRange Is Nothing Then 

            rRange = MsgBox("Non valid range. Try again?", vbOKCancel + vbQuestion) 

                If rRange = vbCancel Then 'No retry 

                    Exit Sub 

                Else 'retry 

                    Run "CollectExpressions" 

                End If 

        End If 

         

    strExpression = InputBox("Enter you expession.E.g. >5 or <10", "EXPRESSION COLLECTOR") 

    If strExpression = vbNullString Then Exit Sub 

 

    MsgBox "Using your expression." & vbNewLine _ 

    & "COUNTIF = " & WorksheetFunction.CountIf(rRange, strExpression) & vbNewLine _ 

    & "Top left cell = " & Evaluate(rRange(1, 1) & strExpression) & vbNewLine 

     

     

End Sub 

 

About Add-Ins 

An Excel Add-In is a file (usually with an .xla or .xlam extension) that Excel can load when it 

starts up. The file contains code (VBA in the case of an .xla/xlam Add-In) that adds additional 

functionality to Excel, usually in the form of new functions. 

Add-Ins provides an excellent way of increasing the power of Excel and they are the ideal vehicle 

for distributing your custom functions. Excel is shipped with a variety of Add-Ins ready for you to 

load and start using, and many third-parties Add-Ins are available. 

Creating an Excel Add-in 

You create a Microsoft® Excel add-in by creating a workbook, adding code and custom toolbars 

and menu items to it, and saving it as an Excel add-in file. 

How to create an Excel add-in 

1. Create a new workbook, add code to it, and create any custom toolbars or menu bars. 

2. Compile the Add-In project by clicking Compile Project on the Debug menu in the Visual Basic 

Editor. 

3. If you want, you can protect the project from viewing  

4. Save the add-in workbook as type Excel add-in, which has the extension .xla.  
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Note   When you are creating an Excel add-in, pay close attention to the context in which your code 

is running. When you want to return a reference to the add-in workbook, use the ThisWorkbook 

property, or refer to the workbook by name. To refer to the workbook that is open in Excel 

currently, use the ActiveWorkbook property, or refer to the workbook by name. 

When you have saved the Add-Ins, you can reopen it in Excel to make changes to the project. The 

saved add-in no longer has a visible workbook associated with it, but when you open it, its project 

is available in the Microsoft® Visual Basic® Editor. 

Saving the add-in workbook as an Excel add-in sets the IsAddIn property of the corresponding 

Workbook object to True. 

You can debug an Excel add-in while it is loaded. When you load an add-in, its project appears in 

the Solution Explorer in the Visual Basic Editor. If the project is protected, you must enter the 

correct password to view its code. 

 

How to Install Add-Ins 

The protocol to install Add-In in Excel 2013 is changed as compared to previous version., but the 

change in user interface which came with Excel 2013 was accompanied by a more tortuous 

protocol. It’s not really more complicated once you get used to it, but the first few times it’s an 

adventure. 

To install an Excel 2013 add-in, click on File tab. 

 

This opens the File Tab. Click the Options tab at the bottom of the menu. 
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The Options dialog opens up. Click the Add-Ins item in the list along the left edge of the dialog to 

see the Add-Ins panel. 
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Make sure the Manage dropdown at the bottom shows Excel Add-Ins, then press the Go button. 

Finally this brings up the familiar Add-Ins dialog. 

 

 

 

 

 

 

 

 

 

 

 

If the add-in has been stored in one of the default add-in directories, it will appear in the list. Check 

the box in front of a listed add-in to install it, or uncheck the box to uninstall it. If the add-in does 

not appear in the list, click Browse, and use the Browse dialog to locate the add-in file. 

This long protocol can be shortened in a couple of ways. One way is to add the Add-Ins command 

to the Quick Access Toolbar (QAT). Click the little dropdown button to the right of the QAT, and 

choose More Commands. 
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Click on the left hand dropdown, and choose All Commands. 

 

Scroll down, select Add-Ins, and click the Add button. 
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,  

Press OK and the Add-Ins button appears on the QAT.If you mouse over it, you can see the Add-

Ins tooltip. 

 

Controls From the Control Toolbox Toolbar 

These controls, which are ActiveX controls , offer far more flexibility than their counterparts from 

the Forms toolbar. These Controls are available in both the Excel interface and the Visual Basic 

Editor. The reason they are very flexible is that we can trap their Events. The Event could be a 

simple click, a double click, change (e.g. new selection from a ComboBox), a user leaving the 

control and shifting focus to another control or back to the Excel interface and many more.  

ActiveX controls also have a long list of Properties (Font, Caption, Name, Linked Cell, Height 

and much more). The Properties are dependent on the type of Control, however Properties such as 

the Name are common across all controls as are many other Properties. 

It is rare that an ActiveX control is used without also using some VBA code that is run as one of 

it's Events take place. If you are not familiar with VBA you should probably opt for a Control from 

the Forms Toolbar. When an ActiveX control is added to a Worksheet it is embedded and becomes 

an Object member of the Worksheet, which is also an Object. This will also automatically put us 

into "Design Mode" which in turns allows us to work with the Control without any Events firing. 

To trap any one of the Events of the Control, the Event Procedure must be placed in the Private 

Module of the Worksheet Object. This is done by double clicking the Control (while in design 

mode). This takes you straight to the Private Module and defaults to a particular Event Procedure, 

often the Click or Change Event. To specify another available Event Procedure, ensure you are 

somewhere in an existing Event Procedure, then select one from the "Procedure" Combobox, 

which is located at the top right of the Private Module. 

Add Ins  
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*ActiveX controls are usually fully programmable objects that can be used by developers to create 

highly customised applications within the shell of the original application. 

 

VBA Error Handling 
 

Introduction 

Error handling refers to the programming practice of anticipating and coding for error conditions 

that may arise when your program runs. Errors in general come in three flavors: compiler errors 

such as undeclared variables that prevent your code from compiling; user data entry error such as 

a user entering a negative value where only a positive number is acceptable; and run time errors, 

that occur when VBA cannot correctly execute a program statement.  We will concern ourselves 

here only with run time errors.  Typical run time errors include attempting to access a non-existent 

worksheet or workbook, or attempting to divide by zero. The example code in this article will use 

the division by zero error (Error 11) when we want to deliberately raise an error. 

Your application should make as many checks as possible during initialization to ensure that run 

time errors do not occur later.  In Excel, this includes ensuring that required workbooks and 

worksheets are present and that required names are defined.  The more checking you do before the 

real work of your application begins, the more stable your application will be. It is far better to 

detect potential error situations when your application starts up before data is change than to wait 

until later to encounter an error situation. 

If you have no error handling code and a run time error occurs, VBA will display its standard run 

time error dialog box. While this may be acceptable, even desirable, in a development 

environment, it is not acceptable to the end user in a production environment. The goal of well 

designed error handling code is to anticipate potential errors, and correct them at run time or to 

terminate code execution in a controlled, graceful method.  Your goal should be to prevent 

unhandled errors from arising. 

A note on terminology: Throughout this article, the term procedure should be taken to mean a Sub, 

Function, or Property procedure, and the term exit statement should be taken to mean Exit Sub, 

Exit Function, or Exit Property.  The term end statement should be taken to mean End Sub , End 

Function,  End Property, or just  End.     

The On Error Statement 

The heart of error handling in VBA is the On Error statement. This statement instructs VBA what 

to do when an run time error is encountered.  The On Error statement takes three forms. 

mailto:contactus@marstraining.in/
mailto:rashidraj97@gmail.com
http://www.marstraining.in/


 

This Content is written by Rashid Rizwi, email: contactus@marstraining.in | rashidraj97@gmail.com, 

website: www.marstraining.in , Voice: +91 9870259245 | +91 9867356452 

 

 

On Error Goto 0 

On Error Resume Next 

On Error Goto <label>: 

The first form, On Error Goto 0, is the default mode in VBA.  This indicates that when a run time 

error occurs VBA should display its standard run time error message box, allowing you to enter 

the code in debug mode or to terminate the VBA program. When On Error Goto 0 is in effect, it 

is the same as having no enabled error handler.  Any error will cause VBA to display its standard 

error message box. 

The second form, On Error Resume Next , is the most commonly used and misused form.  It 

instructs to VBA to essentially ignore the error and resume execution on the next line of code. It 

is very important to remember that On Error Resume Next does not in any way "fix" the error. It 

simply instructs VBA to continue as if no error occured. However, the error may have side effects, 

such as uninitialized variables or objects set to Nothing.  It is the responsibility of your code to test 

for an error condition and take appropriate action.  You do this by testing the value of 

Err.Number  and if it is not zero execute appropriate code.  For example, 

    On Error Resume Next 

    N = 1 / 0    ' cause an error 

    If Err.Number <> 0 Then  

        N = 1 

    End If 

This code attempts to assign the value 1 / 0 to the variable N. This is an illegal operations, so VBA 

will raise an error 11 -- Division By Zero -- and because we have On Error Resume Next in effect, 

code continues to the If statement. This statement tests the value of Err.Number  and assigns some 

other number to N. 

The third form On Error of  is  On Error Goto <label>:which tells VBA to transfer execution to 

the line following the specified line label. Whenever an error occurs, code execution immediately 

goes to the line following the line label.  None of the code between the error and the label is 

executed, including any loop control statements.  

    On Error Goto ErrHandler: 

    N = 1 / 0    ' cause an error 

    ' 

    ' more code 

    ' 

    Exit Sub  

    ErrHandler: 

    ' error handling code 

    Resume Next 

    End Sub  

Enabled And Active Error Handlers 
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An error handler is said to be enabled when an  On Error statement is executed.  Only one error 

handler is enabled at any given time, and VBA will behave according to the enabled error 

handler.  An active error handler is the code that executes when an error occurs and execution is 

transferred to another location via a On Error Goto <label>: statement.   

Error Handling Blocks And On Error Goto 

An error handling block, also called an error handler, is a section of code to which execution is 

tranferred via a On Error Goto <label>:  statement. This code should be designed either to fix the 

problem and resume execution in the main code block or to terminate execution of the procedure. 

You can't use  to the On Error Goto <label>:  statement merely skip over lines. For example, the 

following code will not work properly: 

    On Error GoTo Err1: 

    Debug.Print 1 / 0 

    ' more code 

Err1: 

    On Error GoTo Err2: 

    Debug.Print 1 / 0 

    ' more code 

Err2: 

 

When the first error is raised, execution transfers to the line following Err1:. The error hander is 

still active when the second error occurs, and therefore the second error is not trapped by the On 

Error statement. 

  

The Resume Statement 

The Resume statement instructs VBA to resume execution at a specified point in the code.  You 

can use  Resume only in an error handling block; any other use will cause an error. Moreover, 

Resume is the only way, aside from exiting the procedure, to get out of an error handling block. 

Do not use the Goto statement to direct code execution out of an error handling block.  Doing so 

will cause strange problems with the error handlers. 

The Resume statement takes three syntactic form: 

Resume 

Resume Next 

Resume <label> 

Used alone, Resume causes execution to resume at the line of code that caused the error.  In this 

case you must ensure that your error handling block fixed the problem that caused the initial error. 

Otherwise, your code will enter an endless loop, jumping between the line of code that caused the 
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error and the error handling block.  The following code attempts to activate a worksheet that does 

not exist. This causes an error (9 - Subscript Out Of Range), and the code jumps to the error 

handling block which creates the sheet, correcting the problem, and resumes execution at the line 

of code that caused the error. 

 

    On Error GoTo ErrHandler: 

    Worksheets("NewSheet").Activate  

    Exit Sub 

 

    ErrHandler: 

    If Err.Number = 9 Then 

        ' sheet does not exist, so create it 

        Worksheets.Add.Name = "NewSheet" 

        ' go back to the line of code that caused the problem 

        Resume 

    End If 

 

The second form of Resume is Resume Next . This causes code execution to resume at the line 

immediately following the line which caused the error.  The following code causes an error (11 - 

Division By Zero) when attempting to set the value of N. The error handling block assigns 1 to the 

variable N, and then causes execution to resume at the statement after the statement that caused 

the error. 

    On Error GoTo ErrHandler: 

    N = 1 / 0 

    Debug.Print N 

    Exit Sub 

 

    ErrHandler: 

    N = 1 

    ' go back to the line following the error 

    Resume Next 

 

The third form of Resume is Resume <label>: . This causes code execution to resume at a line 

label. This allows you to skip a section of code if an error occurs. For example, 

     On Error GoTo ErrHandler: 

    N = 1 / 0 

    ' 

    ' code that is skipped if an error occurs 

    ' 

    Label1: 

    '  

    ' more code to execute 

    ' 

    Exit Sub 
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    ErrHandler: 

    ' go back to the line at Label1: 

    Resume Label1: 

 

All forms of the Resume clear or reset the Err object. 

Error Handling With Multiple Procedures 

Every procedure need not have a error code. When an error occurs, VBA uses the last On Error 

statement to direct code execution. If the code causing the error is in a procedure with an On Error 

statement, error handling is as described in the above section. However, if the procedure in which 

the error occurs does not have an error handler, VBA looks backwards through the procedure calls 

which lead to the erroneous code. For example if procedure A calls B and B calls C, and A is the 

only procedure with an error handler, if an error occurs in procedure C, code execution is 

immediately transferred to the error handler in procedure A, skipping the remaining code in B.  

A Note Of Caution 

It is tempting to deal with errors by placing an On Error Resume Next statement at the top of the 

procedure in order to get the code to run without raising an error.  This is very bad coding practice. 

Remember that using On Error Resume Next  does not fix errors.  It merely ignores them.  

 

Why Loops? 

The purpose of a loop is to get Excel to repeat a piece of code a certain number of times. How 

many times the code gets repeated can be specified as a fixed number (e.g. do this 10 times), or as 

a variable (e.g. do this for as many times as there are rows of data). 

Loops can be constructed many different ways to suit different circumstances. Often the same 

result can be obtained in different ways to suit your personal preferences.  

 

VBA Loops 

Do While–Loop – Examines if the condition is true before performing action. It would continue 

to loop while the condition is true. 

While condition 

   [ statements ] 

Wend 
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Do-Loop While – Examines if the condition is true after performing action. It would perform the 

action at least once. 

 

Do Until-Loop - Examines if the condition is false before performing action. It would continue 

to loop while the condition is false. 

Do-Loop Until - Examines if the condition is false after performing action. It would continue to 

loop while the condition is false. It would perform the action at least once. 

For-To-Next – Used for the finite looping. The loop will work from start value to end value by 

incrementing values. 

For Each-Next – Used for performing actions for each item in a group or range. 

 

Procedures Examples 

To Protect a  sheet 
Sub protect() 

Dim strPassword As String 

strPassword = InputBox("Enter the password for the worksheet") 

Worksheets("Sheet1").Protect password:=strPassword, Scenarios:=True 

End Sub 

 

To Unprotect a  sheet 
Sub unprotect()     

ActiveSheet.Unprotect 

End sub 

 

To Print a sheet 
Sub print1() 

ActiveSheet.PageSetup.Orientation = xlLandscape 

ActiveSheet.PrintOut 

End Sub 

 

To make gridlines off of sheet 
Sub Gridlines() 

mailto:contactus@marstraining.in/
mailto:rashidraj97@gmail.com
http://www.marstraining.in/


 

This Content is written by Rashid Rizwi, email: contactus@marstraining.in | rashidraj97@gmail.com, 

website: www.marstraining.in , Voice: +91 9870259245 | +91 9867356452 

 

 

ActiveWindow.DisplayGridlines = False 

End Sub 

 

 

Defining the range name 
Sub range_Name() 

Range("a1:b5").Name = "raj" 

End Sub 

 

To select entire Column 
Sub columns_select() 

Columns(“D”).select) 

ActiveCell.Entirecolumn.Select 

Columns(“A:D”).select) 

End sub 

 

To select entire Row 
Sub row_select() 

ActiveCell.Entirerow.Select 

 

Columns(“1”).select) 

Columns(“1:5”).select) 

End sub 

 

Deleting the sheet without display alert 
Sub Sheet_Delete() 

Application.DisplayAlerts = False 

ActiveSheet.Delete 

End Sub 

 

To delete conditional formatting 
Sub del_cond_format() 

Range("a1").CurrentRegion.FormatConditions.Delete 

End Sub 

 

To clear validation 
Sub Valid_Clear() 

Selection.Validation.Delete 

End Sub 
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To create a series 
Sub series() 

START = InputBox("Enter start value") 

END1 = InputBox("Enter END value") 

STE = InputBox("Enter STEP OF INCREMENT") 

 

For i = START To END1 Step STE 

     

    ActiveCell.Value = i 

    ActiveCell.Offset(1, 0).Select 

     

Next i 

End Sub 

To use vbOKCancel 
Sub Welcome() 

MsgBox "Welcome to VBA", vbOKCancel, "Rashid Rizwi" 

End Sub 

 

To change font color 
Sub Color_Change() 

'sub for the input name & city & if the city =mumbai then change the colour 
Cells.Clear 

Name = InputBox("Enter your name") 

city = InputBox("Enter city") 

MsgBox Name & " " & city 

Cells(1, 1).Value = UCase(Name) 

Cells(1, 2).Value = UCase(city) 

 

If Cells(1, 2).Value = "MUMBAI" Then 

    Cells(1, 2).Font.ColorIndex = 3 

Else 

    Cells(1, 2).Font.ColorIndex = 5 

End If 

   

End Sub 
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Sub Font_Color() 

 

’Changing Font Color 
 

    Selection.Font.ColorIndex = 6 

 

End Sub 

 

To change back color 
Sub Back_Color() 

 

’Changing Backt Color 
 

    Selection.Interior.ColorIndex = 6 

 

End Sub 

 

To Count Workbook 
Sub workbook1() 

MsgBox Workbooks.Count 

End Sub 

 

To insert worksheet 
Sub Inser_Sheet() 

'Sub Insert the sheet after the current sheet 
Sheets.Add after:=ActiveSheet 

End Sub 

 

To insert n no of worksheets same time 
Sub Sheets() 

'Sub no of sheet to be insert 
add1 = InputBox("Enter the no of sheet to insert") 

For i = 1 To add1 

    Sheets.Add after:=ActiveSheet 

Next i 

End Sub 
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To insert worksheet at the end  
Sub Ins_Sheets_End() 

'Insert the sheet at the end of the current sheet 

 
a = Sheets.COUNT 

MsgBox a 

Sheets(a).Select 

    Sheets.Add after:=ActiveSheet 

End Sub 

 

To delete a worksheet 
 

Sub Del_Sheet() 

'Delete the sheet 
       ActiveSheet.Delete 

       End Sub 

 

To rename a worksheet 
 

Sub Ren_Sheet() 
‘Select the sheet & rename 

 

SH = InputBox("Enter the sheet name to select") 

Sheets(SH).Select 

 

rena = InputBox("Enter the  new name to sheet") 

Sheets(SH).Name = rena 

End Sub 

 

Take input as sheet name from excel sheet. 
 

Sub With_Selection() 

'Example ofWith Selection 

 

    With Selection.Font 

        .Name = "Arial" 

        .FontStyle = "Regular" 

        .Size = 12 
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        .Underline = xlUnderlineStyleNone 

        .ColorIndex = 5 

    End With 

End Sub 

 

To display all sheets name in msg box 
Sub Sheets_Name() 

 

For Each sht In ActiveWorkbook.sheets 

    MsgBox sht.Name 

  Next 

   

End Sub 

 

 To increase the column width 
Sub Column_Width() 

 Dim ch As Integer 

 ch = InputBox("Enter the Column Width(points):") 

 Selection.ColumnWidth = ch 

 End Sub 

 

1. To increase the row height 

 Sub Row_Height() 

 Dim ch As Integer 

 ch = InputBox("Enter the row height(points):") 

 Selection.RowHeight = ch 

 End Sub 

 

To autofit rows & columns 
    Sub AutoFit_Rows_Column() 

    Cells.Select 

    Selection.Rows.AutoFit 

    Selection.Columns.AutoFit 

End Sub 

 

To insert a chart for fixed range 
Sub chart1() 

ActiveSheet.Shapes.AddChart.Select 

ActiveChart.SetSourceData Source:=Range("Chart!$A$1:$B$9") 

ActiveChart.ChartType = xlColumnStacked 

End Sub 
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To insert a chart for current range 
Sub chart1() 

ActiveSheet.Shapes.AddChart.Select 

ActiveChart.SetSourceData Source:=Range(“A1”).CurrentRegion 

ActiveChart.ChartType = xlColumnStacked 

End Sub 

 

To unhide rows and columns 
Sub unhide() 

Cells.Select 

Rows.Hidden = False 

Columns.Hidden = False 

Range(“A1”).Select 

End Sub 

 

Write VBA Code to remove blank spaces from selected Cells 
 

Sub Remove_Blank_Space() 

 

For Each cell In Selection 

 

Cell.Value = worksheetFunction.Trim(Cell.Value) 

 

Next 

 

End Sub 

 

Write a VBA Codes to change the number with two decimal format. 

 
Sub Two_Dec() 

 

For Each Cell In Selection 

Cell.NumberFormat = "0.00" 

Next 

 

End Sub 

 

Calling Macro 
Sub Calling_Macro() 

'Call the recorded macro from module 2 

Call Module2.test2_Recorded 

End Sub 
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Functions Examples(UDFs) 

 

Function Without Argument to get current month 
Function Curr_Month() 

Dim dt As Date 

dt = Date 

currmth = Format(dt, "mmm") 

End Function 

 

Function QuarterNum(Enter_Date) 
QuarterNum = DatePart("q", Enter_Date) 

End Function 

 

 

Function to check range name existence 
 

Function NameExist(nm As String) As Boolean 

Dim rng As Range 

Dim myname As String 

On Error Resume Next 

myname = ActiveWorkbook.Names(nm).Name 

If Error.Number = 0 Then nameExist = True 

End Function 

 

Numeric Handling 

Function to extract digit 

 

Function ExDig(str As String) 

' To Extract only Digits from any string 

Dim l, i As Integer 

Dim a,char As String 

l = Len(str) 

For i = 1 To l 

a = Mid(str, i, 1) 

If Asc(a) < 65 Then 

char = char + a 

End If 

Next i 

ExDig = char 
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End Function 

 

 

Function to Calculate Itax using nested IF 

 

Function I_Tax(Salary As Double) 

If Salary < 5000 Then 

    test23 = 0 

 

ElseIf Salary >= 5000 And Salary < 10000 Then 

    test23 = Salary * 0.1 

 

Else: test23 = Salary * 0.2 

 

End If 

 

End Function 

Function to get reverse number 

Function Rev(n as integer) 

While(n>0) 

A=n mod 10 

Rev=Rev * 10 + a 

N=n\10 

Loop 

End Function  

String Handling 
To get Initial of passed string 

 

Function Initial(Str As String) 

Dim l, i As Integer 

Dim a, result As String 

Str = " " + Str 

l = Len(Str) 

For i = 1 To l 

a = Mid(Str, i, 1) 

If a = " " Then 

result = result + Mid(Str, i + 1, 1) + "." 

End If 

Next i 

Initial = result 

End Function 
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List of Built in Keywords in VBA: 

Keyword Description 

As As keyword is used with Dim to specify the data type of a variable or argument. 

ByRef 

ByRef keyword is used to pass variables or arguments into procedures and 

functions. 

ByVal 

ByVal keyword is used to pass variables or arguments into procedures and 

functions. 

Case Case keyword is used with Select when we check conditions. 

Date Date keyword is used to define the current date. 

Else Else keyword is used in conditional statements.It is an optional part of it. 

Empty Empty keyword is used to explicitly set a variant data type variable to Empty. 

Error Error keyword is used to generate an error message. 

FALSE FALSE keyword is used to represent the value zero(0) to Boolean variable. 

For For keyword is used with the Next keyword to repeating statements. 

Friend Friend keyword is used to in class modules. 

Get Get keyword is used with the Property keyword while creating objects. 

Is Is keyword is used to compare two object variables which we used as reference. 

Let Let keyword is used with the Property keyword while creating objects. 

Me Me keyword is used in class module or userform. 

New New keyword is used while creating new instance of an object. 

Next Next keyword is used in for …Next loop 

Nothing 

Nothing keyword is used to an object variable to disassociate the variable from an 

object. 

Null Null keyword is used to represent that a variable contains no valid data. 
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On On keyword is used with the Error keyword for error handling. 

Option Option keyword is used for module level settings. 

Optional Optional keyword indicates that an argument in a function is not required. 

ParamArray 

ParamArray keyword is used to allow a dynamic number of arguments for a 

function. 

Private Private keyword is used to declare a procedure which is visible in that code module. 

Property Property keyword is used with the Class keyword while creating objects. 

Public Public keyword is used to declare a procedure which is visible to entire modules. 

Resume Resume keyword is used with the On Error keyword for error handling. 

Set Set keyword is used with the Property keyword while creating objects. 

Static Static keyword is used to represent a static variable or argument 

Step 

Step keyword is used with the For keyword for additional increments and 

decrements. 

String String keyword is used to consist string variables. 

Then Then keyword is used with the If keyword in conditional statements. 

To To keyword is used with the For keyword while repeating statements. 

TRUE TRUE keyword is used to represent the value one(1) to Boolean variable. 

WithEvents WithEvents keyword is used in class modules. 
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